
 
 
OIV 2.6: GETTING STARTED 
 
What is the ARTstor Offline Image Viewer? 
 
The Offline Image Viewer is a presentation software that ARTstor has developed to allow its users to give reliable, 
Internet-independent classroom presentations that incorporate both the Image Groups that they create in ARTstor, as well 
as any personal images that they have saved locally. The Offline Image Viewer (version 2.6) offers additional features 
unavailable in any previous version.  These include: Additional zoomable templates, Undo/Redo functionality, compatibility 
with Mac computers using the Intel Core Duo processor, Image Group preview before importing into the OIV, ability to 
import PowerPoint presentations into the OIV, and ability for Instructor-level users to upload local images and OIV 
presentations from the OIV into their Personal Collection in ARTstor.  
 
How do I get the Offline Image Viewer? 
 
The Offline Image Viewer is available for downloading to all Registered ARTstor Users. First, log onto your ARTstor user 
account and then click on the “Tools” toolbar button. When you select the "Download Offline Viewer" option, you will be 
prompted to accept the ARTstor “Terms and Conditions of Use” - click on the "Accept" button to proceed. A popup window 
will appear, listing all of the currently available versions of the Offline Image Viewer, with the recommended version for 
your workstation pre-selected. Click on the "Submit" button to begin the download. Another popup window will prompt 
you to choose between opening and saving the new file. Click on the "Save" button and select the location on your 
computer to which you would like to save the installation file. The installation process will vary, depending on whether you 
are using a PC or a Mac, but in general, double-clicking on the installation file will begin the process of installing the 
program onto your computer. Once the installation is complete, the Offline Image Viewer will be available on your 
computer just like any other software program. 
 
How do I assemble my collection of images? 
 
First, open the Offline Image Viewer by double-clicking on the program shortcut. You will see a Getting Started guide, 
which asks you whether you want to open an existing presentation, or create a new presentation using ARTstor images or 
your own local images. You may use either source to begin compiling your collection of images. 
 

 If you select the “Create a new 
presentation from ARTstor 
images” option, you will be 
prompted to enter your 
ARTstor email address and 
password. This is the same 
combination that you use to 
log onto your ARTstor account. 
You will then see a list of the 
folders, the same list that you 
would see in ARTstor online 
after logging onto your 
account. Double-click on a 
folder to view the Image 
Groups saved within. You may 
preview your Image Group in 
the window to the left.  Once 
you have selected an Image 
Group, click on the “Open” 
button to begin the download. 
When you are within the 
program, you can also 
download ARTstor Image 
Groups by going to the 
“Insert” toolbar menu and 
selecting the "Image Group(s) 
from ARTstor..." option, or 
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else clicking on the "Download image group(s) from ARTstor" icon ( ), which is located in the upper left corner of 
the Image Palette pane. 

 
 If you select the “Create a new presentation from my own images” option, a new window with your computer’s 

directory will appear. You can now browse to the location on your computer where your local images can be found, 
whether that’s your desktop, hard drive, shared network drive, removable drive, CD, etc. Select the image file(s) that 
you wish to import and click on the “Add” button. Once you are within the program, you can also import local images 
by selecting the "Local image(s)" option from the "Insert" toolbar menu, or else clicking on the "Import local 

image(s)" icon ( ), which is located in the upper left corner of the Image Palette pane. 
 

 You can upload entire PowerPoint presentations into your Offline Viewer presentations.  Each slide becomes a new 
slide in the Slide Editor while the images embedded within the slides are added to the slides in the Image Palette.  
Go to the Insert menu and choose the “PowerPoint presentation…” option.  You may also click on the “Import 
PowerPoint Presentation” icon in the upper-left corner of the Image Palette.  A window with your computer’s directory 
will open. Browse to the location of your presentation and select it by clicking on the file name. Then, click the “Open” 
button.  The full slides will appear in the Slide Sorter and Editor pane and the images within the slides will be added 
as individual image files in the Image Palette pane. 

 
 Whether you download ARTstor images or import your local images, they will appear in the Image Palette. This is the 

pane that runs along the bottom of your screen in the Default Layout of the Offline Image Viewer. The Image Palette 
is the primary workspace that you will use to organize your image collection. If you want to expand it so that you 
have more room to work, you can find the window controls in the upper right corner of the pane. The three icons 

( ) offer three ways to view images and associated data in this window.  The first icon from the left ( ) 

displays the images only, no associated data.  The middle icon ( ) displays the images, work titles and creators.  

The third icon ( ) displays the images and all associated data.  While in the Image Palette, you may use your 
mouse to drag and drop images to rearrange their order. When you click on an image to move it, a thumbnail 
placeholder will appear as a double-headed arrow indicating a space between two images. When you release your 
mouse to drop the image, it will appear between those two thumbnails. To delete any unwanted images, click once on 
the thumbnail to highlight it and then right- (or "Control-") click with your mouse to select the "Delete image(s)" 
option from the Image Palette shortcut menu. Once you have organized your image collection, you should save these 
changes by going to the "File" toolbar menu and selecting the "Save" option. 

 
How do I present my images? 
 
To present the images in your collection, start the Image Palette Slideshow by double-clicking on the first thumbnail to 

open it to full-screen against a black background. You may also click on the "View Image Palette Slideshow" icon ( ) in 
the upper left corner of the Image Palette pane. While in the Image Palette Slideshow, you have several options for 
navigating your presentation. There is a gray toolbar in the upper left corner of the screen, which contains various icons 
for showing data, advancing to the next/previous image, splitting the screen, or jumping out of sequence within the 
presentation. There is also a right- (or "Control-") click shortcut menu, as well as a suite of associated keyboard shortcuts. 
To view a detail, use you mouse to click directly into the image to zoom in; press “Shift” while clicking to zoom out. When 
you are finished with your presentation, click on the “Exit” icon in the toolbar or press “Esc” on your keyboard. 
 
How do I create slides from my images? 
 
While the Image Palette Slideshow allows you a great deal of flexibility when presenting images, you may want a more 
predictable and customizable method of presentation. Like the Offline Image Viewer 2.0, the Offline Image Viewer 2.5 
contains an additional component that allows you to create authored slides, using the contents of your Image Palette as 
source material. However, OIV 2.5 offers more customization options as well as the ability to print slides and Image 
Palette images.  To create slides, you will be using the Slide Editor and Slide Sorter panes – which are located in the top 
half of your screen - as your main workspaces. There are two ways to create a new slide:  
 

 The first method is to select a template and then fill the blank slide with images and text. To create a new blank slide, 
simply click on the "Add a slide" icon ( ), which is located in the upper left corners of the Slide Sorter and Slide 
Editor panes. Alternatively, you may select the "Add a slide" option from the "Insert" toolbar menu or the Slide Sorter 
right- (or "Control-") click shortcut menu. Once you do so, you will be prompted to select a template from the dialog 
box that appears.  

 
 The second method is to start with a selected image (or images) and then pre-fill a template with these selections. 

First, select your image(s) within the Image Palette pane by clicking with your mouse. You may select multiple 
images by either holding the “Shift” key (for sequential images) or the “Ctrl” (or ) key (for non-sequential images) 
down while clicking with your mouse the desired images. Once your images are selected and highlighted, click on the 

"Create slide(s) from selected image(s)” icon ( ), which is located in the upper left corner of the Image Palette 
pane. You can also right- (or "Control-") click with your mouse and select the “Create slide(s) from selected image(s)” 
option from the resulting shortcut menu.  
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In either case, once you create a slide, a thumbnail preview will appear in the Slide Sorter in the left side of your screen, 
while the slide itself will be available for editing in the Slide Editor on the right-hand side. When you click on the preview 
in the Slide Sorter, the slide will appear in the Slide Editor. Remember, though you might start out with a template, the 
slides remain completely editable. If you need help choosing a template, please see the list below for guidance (the gray 
areas represent images, while the black lines represent text): 
 
 
 
How do I customize my slides? 
 
Once you have created a slide, you may edit the images or text boxes by adding, moving, re-sizing, or zooming into them 
in the Slide Editor. Even if you created a slide using a template, you are not bound to the arrangement of the image 
placeholders and text boxes as defined by the chosen template. At the top of the Slide Editor, you will see a toolbar 
containing icons that will help you customize your slides: 
 

 
 

 Adding and editing images 
If you have created a slide from a template, the empty image placeholders in the Slide Editor will instruct you to 
“Place image here.” Find an image in the Image Palette below, then drag and drop it into the empty placeholder.  

To add an additional image, select the “Add an image” icon ( ) from the Slide Editor tools at the top of the pane. 
Another image placeholder will appear on your slide – simply drag another image from the Image Palette to fill it.  

If you need to move an image, make sure that the “Move” icon ( ) is selected in the Slide Editor toolbar. Then, click 
on the image and drag it to a new location. To re-size your image, click on the image so that a dashed outline 
appears around it. Using any of the 8 square handles at its corners and sides, drag the dashed outline until the image 
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is sized as you like it. Once you have re-sized your placeholder, the image within may no longer fill the entire space. 
In order to enlarge/shrink the image to fill the entire placeholder space, right- (or “Control”-) click on the image and 
select the “Fit to frame” option from the resulting shortcut menu.  
 

If you want to save a zoomed detail on your slide, select the Zoom tool ( ), then, click into an area of the image to 
zoom into it. If you need to pan to another section of the zoomed-in image, select the Pan tool ( ) and then use 
your mouse to click and drag to move to a different area. 

To add a shape, click on the “Add a shape” icon ( ), and adjust the size and placement by clicking and dragging the 
border.  To adjust properties such as line thickness, color, opacity and shape fill, click on the shape so that it is 
highlighted, right click and select “Properties”.   

 
 Adding and formatting text 

In addition to adding images, you may also add text blocks to your slide. If you have created a slide from a template, 
empty text boxes will instruct you to “Double-click to add text.” You may key your comments directly into the box 
after double-clicking with your mouse. You can also import the data attached to any image file into a text box by 
dragging that image from the Image Palette into the empty text box. Whether you are importing an ARTstor image or 
a local image, you will be prompted to select which data fields you want to add. Make your selections and click the 
“OK” button. The imported text will automatically populate the text block. To add an additional text box, select the 

“Add a text box” icon ( ) from the Slide Editor toolbar at the top of the pane. A blank text block will appear on your 

slide. To move a text box, make sure that the “Move” icon ( ) is selected, and then, click on the text box and drag it 
to a new location. To re-size any text block, click on the box so that a dashed outline appears around it. Using any of 
the 8 square handles at its corners and sides, drag the dashed outline until the text box is sized as you like it. To 

format the text, double-click into the box to select the text within. Select the “Set font attributes” icon ( ) so that a 
new window opens, presenting you with options for adjusting the font, size, style, color, and alignment of your text. 
Make your selections and then click on the “OK” button.  
 

 Editing the slide layout  
 
To create a border or set a background color for an image or text box, click on the desired object to select it. Then, 

click on the “Properties” icon ( ) in the Slide Editor toolbar. Choose the desired color, opacity, and thickness for 
your border or background and then click on the “OK” button to apply the changes. Once you choose a color, the 
change will be reflected in the slide display. If you would like to set a background color for the entire slide – not 
simply individual images or text boxes – go to the “Format” toolbar menu and select the “Background” option. Choose 
the desired color from the palette provided to change the overall color for the entire slide. 
 
To set defaults for font family, style and size, slide background and foreground color, and slide size, go to Edit in the 
toolbar menu, “Preferences”, and “Defaults” (bottom icon to the left). 

 
How do I present my slides? 
 
Once you have edited your images and text, as well as designed the overall layout of your slides, you are ready to present 
them in the slide Presentation Mode. During your presentation, your slides will appear in the order that they are listed in 
the Slide Sorter. If you would like to change the order of slides, click and drag the thumbnail previews within the Slide 
Sorter to re-arrange their order. While organizing your presentation, you may find the need to delete a slide. Click on the 

slide preview in the Slide Sorter, then, click on the “Remove a slide” icon ( ) in the upper left corner of the Slide Sorter 
pane. To begin your presentation, go to the “View” menu and select the “View Presentation” option. You may also click on 

the “View presentation” icon ( ) in the upper left corner of the Slide Sorter or Slide Editor pane. 
 
When your presentation begins, a quick start guide will outline the various keyboard shortcuts that you can use to 
navigate through your presentation. Your slides will appear just as you have designed them in the Slide Editor, and in the 
order they are listed in the Slide Sorter. To advance to the next slide, press the Space bar or the “PageDown” key. To view 
the previous slide, press the “Shift” key and then the Space bar, or the “PageUp” Key. To view the slide so that individual 
image/text objects are introduced one at a time, hold down the Shift key, then use the right and left arrow keys. If you 
have incorporated a zoomable slide template into your presentation, clicking into the image with your mouse will allow 
you to zoom in for more details. When you are finished giving your presentation, press the “Esc” key. 
 
How do I print my slides and images from the Image Palette? 
 
To print slides go to File, “Print”, and “Slides”.  You can select the slide layout (two or four slides per printed page) and 
page margins. To print images from the Image Palette, go to File, “Print”, and Palette Images.  There will be one image 
and associated data per page.    
 
How do I save my presentation? 
 
After creating or making any changes to a presentation in the Offline Image Viewer, you will need to save it. You have a 
few options for saving your presentation file: 
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 To save your working file, go to the “File” menu and select the “Save” option. You will be prompted to choose a 
location on your computer’s directory and name your presentation file (.prs). You can save a presentation file to your 
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 thod applies to those institutions that do not use a proxy server and relies on an alternative method of 

remote authentication called the Remote Access Grace Period. In simple terms, whenever an ARTstor user logs onto 

hard drive, network, or any portable media devices (e.g. disk, CD or Zip drive). 
If you would like to make a copy of an existing file, you can save it under a different name. Go to the “File” menu, 
point your mouse to “Save As,” and then select the “Save with a different name…

 To share your slide presentation so that others may view it, you can save a Read-Only version. Go to the “File” men
point to “Save As,” and then select the “Export as Read-Only presentation…” option. Your p
as a .shw file that cannot be edited by the viewer. Please note that the resulting file will only preserve the slides that 
you created, not the individual images in your Image Palette collection. 
If you are more comfortable (or restricted to) the prior version of the Offline Image Viewer, you still have the option 
to save your file into the older format. Go to the “File” menu, point to “S
1.2 format…” option. Only the full-size images from the Image Palette will be saved in the resulting .prs file; none of 
the slides that you may have created from this collection of images will be exported. 
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 Go to the File button in the toolbar and choose the “Upload all slides” option from t
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 Your slides will be added to your Personal Collection in a category titled “OIV Slides.”  These slides/Personal 
Collection images are also saved into their own Image Grou
Image Group will be the title of the OIV presentation file. 

 I use the ARTstor Offline Image Viewer remot
 
If you would like to use the Offline Image Viewer remotely, you may down
L
begin working on a presentation file. The first time that you launch the Offline Image Viewer 2.5 after installation, you
be asked to authenticate the program. As a security measure, ARTstor requires that every installation be authenticated 
the first time the program is opened, as well as every 30 days thereafter. All you need to do so is a valid ARTstor account, 
so that you can enter your email address and password when prompted to authenticate. To successfully authenticate, yo
may use one of two methods:  
 

 The first involves connectin

enter your proxy server’s address and port number into the required fields. Once you have connected to your proxy
server - and you can be identified as a valid user from an authorized institution - you will be able to successfully 
authenticate. 

The second me
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their registered account from a valid IP address, they are granted a 120-day period during which time they may 
access ARTstor from any location. To reset the clock for this grace period, all the user has to do is log back onto their 
account from a valid IP address - whether they do this while on campus or connecting through a proxy server. Th
Remote Access Grace Period will allow you to authenticate the Offline Image Viewer 2.5 remotely, so that when you 
are prompted to enter your registered email address and password, ARTstor will check to see if you have touched 
your account with in the last 120 days. If you have time remaining in your grace period, you will be able to 
authenticate successfully. If you do not, you may reset the grace period by logging onto your ARTstor account from
valid IP address and then try authenticating again.  

e you have successfully authenticated the program, y

is 

 a 

  
Onc ou will be able to use the Offline Image Viewer for 30 days 

fore being prompted to renew the certificate. If you are not able to authenticate before your 30 day period has expired, 
ain 

ine Image Viewer? 

s compatible: 
ttp://www.artstor.org/info/using_artstor/techspecs.jsp

be
you may continue to use the program, but any ARTstor content will no longer be visible. The ARTstor content will rem
unavailable for use until you re-authenticate the Offline Image Viewer. At any time, you may check the status of your 
certificate by going to Help and selecting “Authenticate OIV”. A new window will open, listing the expiration date for your 
certificate. When you click on the “Authenticate Now” button, you will then be prompted to enter your ARTstor email 
address and password to complete the re-authentication. 
  
How can I get help with using the ARTstor Offl
 
First, check the ARTstor Technical Specifications to make sure that your computer i
h . PC users should have Windows 2000 or XP, while Mac users will 

hile working in the need a minimum of OS X 10.3 or higher. Java Sun version 1.3 or higher is required for all users. W
Offline Image Viewer 2.0, you can always consult the Help Index by going to the “Help” toolbar button and selecting the 
“Help topics” option. ARTstor User Services is also available for user support Monday through Friday, 9 AM – 8 PM, 
whether by phone (toll free, USA only: 888-278-0079) or email (userservices@artstor.org).  
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